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1 Overview

1.1 Introducing Mail Communicator

Introducing Mail Communicator

Mail Communicator allows you to communicate with your clients and keep in touch with your
customers in a more convenient way. It puts the world of the online email marketing on your desktop,
and gives you a powerful tool to promote your business on the internet.

Mail Communicator is the best email marketing software on the market today. Mail Communicator was
developed to offer the Internet Market a powerful but user-friendly tool to promote your business.

Mail Communicator allows you to send Personalized messages to your customers, subscribers and
friends. With the built-in Email Reader function, you can check your mailbox contents before
downloading the messages to your PC. You can also process the messages automatically with
Message Rules, run auto-responders and newsletter list server. A powerful mailing list manager utility
helps manage your mailing list easier.

Sending "Personalized" bulk email messages
Mail Communicator allows you to send "Personalized" messages to a mailing list in a customized
format, you can insert any customized fields into your message and replace it with the information from
your mailing list. It supports Plain Text and Rich Text (HTML) format, and attachments. You can
specify the number of messages you want to send at a specified time. You can compose messages off
line and send them the next time you connect. You can send email directly from MS Access, SQL
database and MS Outlook address book or folder .

Viewing and Reading Mail Messages
You can view a list of messages in your mailbox by downloading the message headers only, or read
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the entire message as your normal email reader program. Using the message list and preview panel,
you can view a list of messages and read individual messages at the same time. When you view a list
of messages, you can delete the message from your mail server directly without download it. You can
reply to a single message or reply to all messages. You can also add senders to a mailing list.

Managing mutliple mail Accounts and subscribe Mailing List
If you have several mail accounts, you can use them all in Mail Communicator. You can attach a
mailing list to each account, so that your mail account will work as a list server, your clients can
subscribe or un-subscribe to your mailing list.

Process Messages Automatically (or Auto-Responders)
Mail Communicator can help you to processing your message automatically and efficiently; it allows
you to run your own auto-responders from your desktop. You can use rules in Mail Communicator to
automatically reply to or forward certian messages, send a specified message to a mailing list, add or
remove sender from a mailing list(same as subscribe and un-subscribe), or run an external program.

Managing Mailing List
You can easily maintain your mailing list with the Mailing List Editor. When you create a new mailing
list, a Mailing List Wizard will guide you through the process, you can also import a mailing list file from
other format or Microsoft Access Database. You can add or remove email addresses from your mailing
list.

Managing Message Templates
If you send regular bulk emails, running newsletters or creating regular follow-ups, you can manage
your messages or articles easily with Message Template Editor. You can compose your message in
both Plain Text and Rich Text (HTML) and format and manage them in a list view box.

Mailing List Processing Tools
With Mailing List Processing Tools, you can sort and de-duplicate your mailing list, remove email
addresses from one mailing list file against another, merge several mailing lists into one mailing list,
split a mailing list into several mailing lists, retrieve email addresses from Outlook Express or any other
file format.

Related Topics:
Getting Started With Mail Communicator
Features

1.2 Features

Features

Mail Communicator is the best email marketing software on the market today. Mail Communicator was
developed to offer the Internet Market a powerful but user-friendly tool to promote their business on the
Internet.

Mail Communicator allows you to send "Personalized"  messages to your customers, subscribers and
friends. With the built-in Email Reader function, you can check your mailbox contents before
downloading the messages to your PC. A powerful mailing list manager utility helps manage your
mailing list easier.

The following is a summary of Mail Communicator 's powerful features:
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1. Sends personalized email messages to unlimited mailing lists.
2. Powerful Pre-Formatted customized message templates
3. Supports mail attachments
4. Supports both Plain Text and Rich Text (HTML) message format
5. Send email directly from your MS Outlook, MS Access and SQL database
6. Validate email addresses
7. Multiple keyword filters when sending emails
8. Incoming email box checker
9. Built in email reader
10. Reply to sender or senders of all the selected incoming email messages
11. Checks incoming email headers before downloading
12. Processing message automatically with message rules
13. Run auto-responders from your desktop.
14. Run newsletter list server from your desktop.
15. Auto-creates a mailing list or Removes a list from Incoming mail
16. Auto Undeliverable email address remove
17. Mailing list sorting and duplication
18. Retrieve email address from any email folder file such as Netscape, Eudora and Outlook etc.
19. Retrieve email address from any file
20. Auto Follow Up
21. Support ODBC, XML, Outlook and Excel

and much more.

Mail Communicator will save hours of your valuable time, which can then be used for everything you
need to do in your on-line marketing business.

Related Topics:
Introducing Mail Communicator
Getting Started with Mail Communicator

1.3 Main Screen Tool Bar Summary

Main Screen Tool Bar Summary
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New
You can create new mail, new mail account, new message rule, new mailing list and new message
template.

Mailing List Tools
Mailling list utility for you to manage your mailing list, inlcuding: Sort and De-duplicate email addresses,
remove email addressed, merge mailing list, split mailing list, retrieve mail addresses from file.

Mail Validator
Verify email addresses in a mailing list to determine if an email address is valid or not. It will help you to
remove the invalid email address without sending the email and reduce bounce back rate.

Email Tracker
Visit your Email tracking account to see the campaigns you're tracking and the details on those
campaigns.

Reports
This is where you can see the Mail Campaign Report. This report will show you the details of the
Campaigns you've sent out.

Help
Help file providing step-by-step guide on how to use Mail Communicator.

Tutorial
Link to Mail Communicator tutorial with screen shots and tips.

Related Topic:
Add a mail account
Create a mailing list
Create a message template
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System Configuration

1.4 Understand Message Format

Understand Message Format

Mail Communicator supports both HTML (Rich Text) and Plain Text file format. You can specify the
default format under the "File/Configuration" window.

When you create messages using HTML formatting, only mail programs that support HTML can read
the formatting. If the recipient's mail program does not read HTML, the message will be displayed as
plain text with an HTML file attached.

You can also choose to send the the Email using HTML format only. This option is good to reduce the
size of the email, however, if the recipient's mail program does not read HTML, the message will not
available for viewing.

To use HTML formatting

In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML).

Notes
To edit the HTML source tags, click the Source tab and start editing.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

1.5 Understand Mailing List File Format

Mailing List File format

You can send emails from a plain text mailing list file, MS Access, SQL or MS Outlook address or
folder. Your mailing list may contain multiple fields. The following are some samples to show you how a
plain text mailing list file looks like.

A plain ASCII text file format is a common mailing list format for many bulk email program. It expects a
plain text file with one email address on a seperate line as follows:

   [Email]
   friends@sample-email.com
   Email Marketing <friends@sample-email.com>
   <friends@sample-email.com> "Money make"
   ..........

Note: All of the above formats are correct email address format for Mail Communicator.
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Your mailing list can also contain multiple fields seperated by a comma as seen below :

   [Email], [Name], [Company]
   peter@edynamicsoft.com, Peter Laurent, eDynamicSoft
   david@apexpacific.com, David Liang, Apex Pacific
   .......

Tips:
·   Email address field can be at any column. The following mailing list format is also supported by Mail
Communicator.

   [Name], [Email], [Company]
   Peter Laurent, peter@edynamicsoft.com, eDynamicSoft
   David Liang, david@apexpacific.com, Apex Pacific
   .......

Mailing List Header Field (for example: [Email], [Name] etc) is an option. If your mailing list file does
not include any header field, it still works with the Mail Communicator. But we suggest that you Create
a New Mailing List function to import your existing mailing list file to the Mail Communicator format. For
example:

   friends@sample-email.com
   Email Marketing <friends@sample-email.com>
   <friends@sample-email.com> "Money make"
   ..........

   or

   peter@edynamicsoft.com, Peter Laurent, eDynamicSoft
   david@apexpacific.com, David Liang, Apex Pacific
   .......

If your mailing list is stored in a database or another file format, you can export your mailing list from
the above format and that is used by Mail Communicator. See related topic below for more information.

Related Topics:
Creating a Mailing List
   - Create Mailing List in Mailing List Editor
   - Import External File to create Mailing List
Open an existing Mailing List
Enter or Edit mailing list data manually
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List

1.6 What's a Message Rule

Incoming Message Rule

It is a powerful function allowing you to process mail messages automatically with the message rules. It
works like an auto-responder (Receive Mail Rule), you can use rules in Mail Communicator to
automatically "reply to" or forward certain messages, send a specified message to a mailing list, add or
remove a sender from a mailing list (the same as subscribe and un-subscribe), or run an external
program.
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Go to "File/New/Receive Mail Rule" item from the menu bar. Or click "Mailing Rules" in the tab, then
click "New" icon on the tool bar then select "Incoming Mail Rule". The "Message Rule" screen will show
up.

There are 9 types of actions you can set up with the Receive Mail Rule:

Reply with message

Add Sender to mailing list

Remove Sender from mailing list

Forward to people in the mailing list

Delete it from the server

Send message to people in the mailing list

Run External Program

Process Web Form with mailing list

Send Message to people in Web Form

Related Topics:
Create a rule for mail messages
Processing Message with Message Rules
Apply a rule to incoming messages
Change a rule

1.7 Send Message in HTML Format

Can I send message in HTML format?

Yes, you can send message in HTML format with Mail Communicator.

Mail Communicator has a built-in WYSIWYG HTML editor which allows you to create the HTML
message within the program.

To create HTML format message:
1. Open the Send Mail window by going to File menu, New and Message Template
2. In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML) menu
item. This option is selected by default.

Tips
1. To edit the HTML source tags, click the Source tab and start editing.
2. You can set the default format of the message to HTML format under the File/Configuration
window.
3. When you create messages using HTML formatting, only mail programs that support HTML can
read the formatting. If the recipient's mail program does not read HTML, the message is displayed as
plain text with an HTML file attached.

Related Topics:
Using HTML formatting
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Troubleshooting and FAQ

2 Getting Started

2.1 Getting Started with Mail Communicator

Getting Started with Mail Communicator
 Previous       Top       Next

With Mail Communicator, you can send "Personalized"  bulk email messages to your clients or send
newsletters to subscribers, view messages from your mail box, run auto-responders, manage your
mailing list and message templates.

There are two basic interface modes: Wizard Mode and Classic Mode. You can switch between the
two modes by selecting the "Work Mode" Toolbar icons.

Wizard  Mode : The wizards walk you step-by-step through creating campaigns, creating contact
databases, and setting up list builders. Begin any new project from the Wizards page.

Classic Mode : The Classic interface allows you to access the mail campaign(s) easily without going
through the step-by-step wizard.  Please use this interface only if you want to manage your campaigns
quickly.

If you are a new user to Mail Communicator, please use the Wizard mode to getting started.

The following topics will show you how to start sending and receiving emails in the Classic mode. After
getting started, you'll find there are many different ways to tailor the Mail Communicator to your needs.
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Look in the Help Contents for ideas.

·   To add a mail account, you need your account name and password, and the names of an
incoming(POP) and an outgoing(SMTP) mail server.

Basic Setup
   Configuration of your Internet Connection
   Create a mail account & Set up mail server information
   Create a mailing list

Creating and Sending Mail
   Creating a new Mail
   Insert "Personalized" field in a message
   Change the priority of an outgoing mail message

Viewing and Receiving Mail  Hlp_Receiving_message
   Receiving message from mail server
   Download Message headers only

Related Topics:
   Introducing Mail Communicator
   Features

3 Basic Setup - Wizard Mode

Enter topic text here.

3.1 Create an Email Account

Create a mail account and Set-up your mail server information

Step 1 - This step is to provide the basic information for the new Account. Make sure to fill the "Email
Address" and the "Reply Address". These information will be used when sending emails out using this
Account.
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Step 2 - This is where you need to enter the SMTP (outgoing mail server) server details. If your SMTP
mail server has authentication, you will also need to know the username and password. This
information can be obtained from your (ISP) internet service provider or (LAN) local area network
administrator.

You can also specify how long the pause between emails being sent out at a time. This feature is
useful if you have a limited number of emails that can be sent out by your SMTP server at a time.
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Step 3 -  This is where you need to enter the POP3 (incoming mail server) server details. If your POP3
mail server has authentication, you will also need to know the username and password. This
information can be obtained from your (ISP) internet service provider or (LAN) local area network
administrator.

note: the attached mailing list will be used as the subscribe or un-subscribe list. The program will
automatically put the email address of the incoming email that has "subscribe" as the subject also
"unsubscribe" or "remove"  will remove the email address from the mailing list.
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Step 4 - You can add and apply rules to your Incoming Messages.

You can specify multiple conditions for a single rule by clicking more than one check box. Click the
And / Or  radio button under the Rule Description section to specify whether all of the rule conditions
apply before the specified action occurs (and) or whether at least one must be met (or).
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Step 5 - The final step. Click on the Test Account settings to see if the account you've just set up is
working. It is better to know that you've mistyped a password now than when you're sending out your
email campaign.
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3.2 Create a Mailing List
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3.2.1 Create a Mailing List - List Editor

Creating a Mailing List using the List Editor

This wizard will take you to setup a new Mailing List using the build in Mail Communicator's List Editor.
It is an easy, quick way to setup a new Mailing List in Mail Communicator.

Step 1 - Select the option: I don't have a mailing list yet, I want to create a mailing list with List Editor.

Step 2 - You will need to specify which column you wish to use on your mailing list.

Tips: You can also create your own column to be used in the Mailing list.
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Step 3 - You will need to specify the name, description and location for your new mailing list.
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Step 4 - This is the last page, hit "Finish" to create the mailing list.

3.2.2 Create a Mailing List - Existing Data Source

Creating a Mailing List using an Existing Data Source

This wizard will take you to setup a new Mailing List using an external data source as the basis. This is
a useful feature to help you import your existing mailing list.

Step 1 - Select the option: I already have a data source, I want to Import my contact list from my
existing data source.
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Step 2 - You can import from selected range of data source Text file, Access database (2003 and
before), Outlook, Excel (2003 and before) and XML format files. You can also choose the delimiter for
multiple fielded data sources (normally text sources).
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Step 3 - If you selected the Text file as your data source, you will see the sample data to make sure it
is the correct format.
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Step 4 - You will need to specify the name, description and location for your new mailing list.
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Step 6 - This is the last page, hit "Finish" to create the mailing list.

3.2.3 Create a Mailing List - Open Direcly

Link a Mailing List on an Existing Data Source

This wizard will take you to link an existing data source (list) to the program in order to update the
changes made to the list directly.

Step 1 - Choose the option: I want to open an existing mailing list directly.
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Step 2 - You will need to specify which column you wish to use on your mailing list. You can also
create your own column to be used in the Mailing list.



Mail Communicator V3 Online Help27

©2009 Apex Pacific Pty. Ltd.

Step 3 - This is the last page, hit "Finish" to create the mailing list.

3.3 Prepare Your Message
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3.3.1 Prepare Your Message - Message Draft from Scratch

Create a new Message Draft from scratch

This wizard will guide you to prepare your message from scratch.

Step 1 - Select the option that says: Create a new blank message. you can also choose which
message format you wish to use. Please note that for the HTML format of messages, a plain text
format will automatically be created to support recipients that cannot view HTML format emails.

Step 2 - You will need to specify the name, Subject of the Draft and location for your new Message
draft.
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Step 3 - This is the last page, hit "Finish" to create the new Message Draft.

3.3.2 Prepare Your Message - from Template

Create a new Message Draft from Mail Communicator's template

This wizard will guide you to prepare your message based on the template.

Step 1 - Select the option that says: Create a message with our default Template.
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Step 2 - On this step, you can select from 6 different templates available for you to use.
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Step 3 - You will need to specify the name, Subject of the Draft and location for your new Message
draft.
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Step 4 - This is the last page, hit "Finish" to create the new Message Draft.

3.4 Create Your Email Campaign

Create Your Email Campaign

This wizard will guide you to create your Email Campaign from selecting the list to sending the email
message.

Step 1 - First, you need to select a mailing list for the email campaign to send to. You have 3 options:
Use and existing Mailing List, Create a new Mailing List or send to a single email Address.
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Step 2 - You can choose between creating a new message or Open an existing message from your
"Sent" items.
When creating a new message, you can choose from creating a blank message, creating from your
own Message Draft or from a default Message Draft.
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Step 3 -  You can track your email campaign by ticking the box. The Tracking feature is a subscription
based service. If you haven't setup your Email Tracker account, ticking the box will ask you to setup an
Email Tracking Account.
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Step 4 - This is where you need to put your Campaign message details.
You need to enter your Subject. Attach a file if you wish, set the message priority and reques a read
receipt.
Please note that it is optional for the receiver to agree to send a read receipt.
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Step 5 - This step is to select which Mail Account you would like the email Campaign to be sent from.
You can also create a new Mail Account on this page.
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Step 6 - You can choose how many emails on the mailing list you wish to send to or you can send to all
of the email addresses in the mailing list. You can also put a filter on the sending of the emails by
ticking the box that says "Send Message only of the following condition is applied:" You can also send
the messages in Blind Carbon Copy mode. This is good option to use if you're trying to send your
emails with a big attachment.
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Step 7 - On this step, you can set the "Send Time".

Send Now: Sending the Mail Campaign straight after finished the wizard.

Send at a specific time: Send the Mail Campaign at the specified date and time (the program must be
running at the specified date and time, if not, the next time the program runs, it will try to send the
pending Send jobs).

Send this message by "Send Rules": you can specify the send rules and attach it to the Send Mail
Campaign. This Mail Campaign will stay in your inbox and check against the "Send Rules" every day.
Normally to be used for Follow Up emails.

I don't want to send now: this will put this campaign to the "Message Draft" tab for later editing or
sending.
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Step 8 - This is the last page, hit "Finish" to create the Mailing Campaign Wizard.

3.5 Manage Subscribe and Return Emails

Manage Subscribe and Return Emails

This wizard will guide you to apply a default "Subscribe" and "Unsubscribe" rules to your specified Mail
Account and Mailing List.
The default "Subscribe" rule is that if the incoming email's Subject contains "Subscribe", the program
will add the incoming mail's email address to the Mailing List.
The default "Unsubscribe" rule is that if the incoming email's Subject contains "Remove" or
"unsubscribe", the program will remove the incoming mail's email address from the Mailing List.

Step 1 - In this step, you need to specify which account you wish to add the default
Subscribe/Unsubscribe rule.
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Step 2 - You need to select which mailing list to Subscribe/Unsubscibe to. You can also automatically
delete the email message from the mail server after Subscribe/Unsubscribe.
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Step 3 - This is the last page, hit "Finish" to finish the Subscribe/ Unsubscribe Wizard.
Make sure to tick the box that says "Apply this setting now".

3.6 Track Your Email Campaign Performance

Track Your Email Campaign Performance

Mail Communicator™ also integrates Email Tracking systems that allows you to track your email
campaigns, Track how many visitors open your email campaign, how many click-thrus and sales, and
also calculates ROI.
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In the Email Tracking Report you may:

1. Manage your Campaigns - Create, Edit or even delete your Campaign information as shown
below.
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2. Viewing the Stats - Get a comprehensive report on your Email Campaigns performance, such as:

    * Open - Know how many recipient opens your email message.
    * Click Thru - Know how many recipient click the link on your email message to your website
    * Sales - Know how many recipient finally make the purchase originated from your email message
      (In order to do this you need to insert a tracking code into your order confirmation page , please
click to "My Account" / "ROI Tracking" in the system to find out more.)
    * Bounce Back - Know how many "no good" email address in your list and got bounced back from
the server

There are also few reports types such as:

    * View by History - Display the progress of your campaign over time.
    * View based on Region & Country - Know more where you getting conversion from and aim your
campaign to certain demographic area.

    * Drill down to a complete detail - Comprehensive report on which particular recipient performing
which action on which date.



Basic Setup - Wizard Mode 44

©2009 Apex Pacific Pty. Ltd.

3. Change your Details - Click on the "My Account" link at the top of the screen, this screen will
enable you to change your details such as Name, Address, Credit card information.

4. ROI Tracking - Click on the "My Account" link at the top of the screen, and then click "ROI
Tracking", this screen contains information on how to setup tracking code in your order confirmation
page that will enable you to track sales of your campaigns.

5. Billing Summary - Click on the "My Account" link at the top of the screen, and then click "Billing
Summary" to display the history of your billing.

4 Basic Setup - Classic Mode

4.1 Add a Mail Account

Create a mail account and Set-up your mail server information

You will need the following information from your (ISP) internet service provider or (LAN) local area
network administrator:

·   For receiving emails, you'll need to know the name of  your POP3 mail server (incoming mail
server), and your login name and password.

·   For sending emails, you will need to know the name of SMTP mail server (outgoing mail server). If
your SMTPmail server has authentication, you will also need to know the username and password.
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To add a new mail account (Classic mode):

1. On the File menu, select  New  from menu item and select Mail Account.  (Or by clicking on the
Drop down arrow button of the New button on the Tool bar , and select  Mail Account .)

2. In the New Mail Account dialog box, enter the information as needed on the appropriate tabs.

·   General
Enter the name of new mail account, then the user information with name of the user, name of
organization, email address and reply address.

·   Servers
Server information, Incoming mail server and Outgoing mail server. For receiving emails, you'll need to
know the name of your POP3 mail server (incoming mail server), and your login name and password.
For sending emails, you will need to know the name of your SMTP mail server (outgoing mail server). If
your SMTP mail server has authentication, you will also need to know the username and password.

·   Message Rules
Check the box to select the message rules you have created. For how to create or set-up a new
message rules, please see Message Rules Set-Up.

·   Advance
You can set up the Server timeouts, Incoming mail server, Outgoing mail server and subscribe mailing
list.
The Subscribe/Un-Subscribe rule will check the incoming email Subject for "Subscribe" to add to the
mailing list and "Remove" or "Unsubscribe" to remove the email address from the mailing list.
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You can create multiple accounts by repeating steps 1 and 2 for each new account.

Tips:
Message Rules :  allows you to apply rules to your incoming mail account so that your Mail
Communicator can process your incoming message automatically. For more information, please see
"Create a rule for mail messages".

Advance/Subscribe Mailing List:  allows you to attach a mailing list to your mail account, so that your
mail account will work as a newsletter server to subscribe and un-subscribe your clients from your
mailing list. For more information, please see "Subscribe and Unsubscribe Mailing List".

See Also:
Change settings on an existing mail account

Related Topics:
Create a mailing list
Create a message template
System Configuration
Main Screen Tool Bar Summary
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4.2 Create a Mailing list

Create a mailing list

1. On the File menu, click New and then choose Mailing List . (or on the toolbar, click New from the
drop down menu, and select Mailing List )

2. The Mailing List Wizard screen will show up with 3 options to create a new mailing list.

·   Create a mailing list in Mailing List Editor

Follow the instructions on the Mailing List Wizard to create the mailing list. For details, please
see Create a mailing list in Mailing List Editor.

·   Create a mailing list from an existing Data Source (import)
For more details, please see Import external file/database to a mailing list. 

·   Create a mailing list by open directly from an existing Data Source (linking).
For more details, please see Create a Mailing List - Open Directly

Enter or Edit mailing list data manually On Mailing List Editor
1. Select the cell you want to edit, and press the "Space" bar or double click on the cell to enter into the
Edit mode
2. Press the "Enter" key to move to the next cell.
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Tips :

·   You can add multiple fields such as your name, company name, and your address to your mailing
list file, so that can you send "personalized" messages with the Send Mail function.

·   You can also import a email address from an existing mailing list file or MS Access Database file.
When you import a mailing list file, you can select any field you would like to include in the new mailing
list.

Related Topics:
Create Mailing List in Mailing List Editor
Import External File to create Mailing List
Open an existing Mailing List
Enter or Edit mailing list data manually
Mailing List File format
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List

4.3 Create a Message Template

To create a message template
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A Message draft allows you to manage your messages, follow up on your newsletters in an effective
way. You can also easily manage your messages in a single list view.

1. On the File menu, click New and Select  Message Template . (Or on the Message Draft Tab,
select New from the drop down menu list, and choose a Message Draft )

2. Type the name of your message draft, and a short description and the location of the message draft
to be saved.

Tips:
·   You can open a message from a file by clicking the File  menu item, and select Open . (Or directly
click the "Open" icon from the tool bar)

·   You can save a message to any file by clicking the File  menu item, and select Save As . (Or click
the "Open" icon on the right side of "File Location" to select from local folder)

·   Message drafts supports both Plain Text  and Rich Text  (HTML) formated documents.

Related Topics:
Open an existing message template
Inserting items in a message
Formatting message text
Using HTML formatting
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Creating a Pre-formatted customized message

See Also:
Add a mail account
Create a mailing list
Main Screen Tool Bar Summary

4.4 Subscribe and Unsubscribe to a Mailing List

Subscribe and Unsubscribe to a Mailing List

This function of Mail Communicator allows you to subscribe or unsubscribe your clients from your
mailing list.

Each Mail Account has a Mailing List file attached to it. This mailing list will automatically has a default
subscribe or unsubscribe rule attached to that mail account.

The default "Subscribe" rule is that if the incoming email's Subject contains "Subscribe", the program
will add the incoming mail's email address to the Mailing List.
The default "Unsubscribe" rule is that if the incoming email's Subject contains "Remove" or
"unsubscribe", the program will remove the incoming mail's email address from the Mailing List.

Tips :
You can also use Message Rules to provide more complicated functions and actions.

Related Topics:
Add a mail account
Receiving message from mail server
Download Message headers only
Get Returned(undeliverable) Email addresses
Processing message with Message Rules

4.5 Configuration - General

Configuration of Internet Connection

System configuration allows you to set up settings for the program.

1. Click File menu and choose Configuration.
2. On the Configuration window, select the appropriate options as request.
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General Setting

Always add undeliverable and unsubscribe email address to master Removed file : this option
allows you to build a master removed list file which contains all the email addresses to be removed.
You can always use the Remove mailing list tool to clean your mailing list to remove the email
addresses you do not want to send. Check the box to delete the message from server after added to
the removed file.

Check New Message Automatically : If your mail account has a Message Rule, enable this option will
allow the program to process your message automatically with your Message Rules. You can turn it off
if you do not want to process the message automatically.

Default Mail Sending Format : to specify which format to be used for your default mail sending
format. For example, if you choose HTML format, when you create a new Mail by clicking the New Mail
button, it will use HTML format for your message.

Add to Tray Icon when minimize window : This option will add your program to the window's Tray
Icon task bar when you minimize Mail Communicator screen.

Default Mail Sending Format:  You can choose either HTML or txt. format as your default format
which will be used when you compose the mail.  Check the box of "HTML format only" if you prefer to
send your message only in HTML format to the intended recipient (Mail Communicator automatically
sends message in both HTML and txt. format).

Enable Preview Panel: You can enable or disable the preview Panels for "Email Campaign" and
"Incoming Email" tabs to preview the emails stored in the folders there.
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Continue to send the mail campaign in Outbox : This option allows you to automatically re-send the
mail campaign in the Outbox folder. For example, if your internet connection is dropped when you are
sending, and the program is interrupted before it completed all the addresses. To enable this option,
the program will continue to send the message start from where it stopped last time.

Connection
It allows you to choose your internet connection. By default it is direct connection. If your PC is
connected to the internet through a Proxy Server(or firewall), please choose Proxy Server option. If
your server or proxy requires authentication, enter your username and password as well.

Filter
Allows you to specify a list of keywords to filter out addresses you do not want to mail to. For example,
.edu, .gov, .org, postmaster, Spam, etc... Any email addresses containing these keywords will be
filtered out by the program.  First enter the keywords in the small box at the bottom, then click "Add'
button. The keywords you entered will show in the above big box. You can use 'Edit" or "Remove"
button to manage filter keywords.

Related Topics :
Troubleshooting and FAQ
Technical Support

5 Creating and Sending Mail Message

5.1 Creating a new Mail

To creating a new Mail

1. On the File menu, click New and select EMail Campaign . (Or select New dropdown from the Mail
Communicator tool box, and click the Create New Mail).

2. In the From box, select a mail account you wish to send the mail from. If you have not set up an mail
account yet, please click here to add a mail account.
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3. In the To box, click the Open Mailing List icon next to the To box and select a new mailing list file
you would like to send. Please click here to see how to create a mailing list.
Note: you can send emails to MS Access and SQL Server database directly. Please click "here" for
more details.

4. In the Subject box, type a message title.

5. You can insert a personalized field name to the body of your message or the Subject line, the Mail
Communicator will replace the field name with the correspondent data value from your mailing list.
Simply move your cursor to the place you want to insert the personalized field in the Message or
Subject Box, then click the Insert Personalized Field box and choose the field name you wish to
insert. For more information please click Pre-formatted customized message.

6. Type your message or insert the message template, and then click the Send button on the toolbar to
send the mail.

Tips:
Draft Mail Flder: store a draft mail campaign.
Outbox Mail Folder: store the mail campaign to be sent later
Send Items Mail Folder: store the mail that has been sent.

Save mail campaign to send it later
You can save a draft of your mail campaign to work on or send it later. To save a mail campaign, click
the File Menu  and select Save to send later menu item. The mail will be saved in the Draft folder.
You can open the mail campaign later by double clicking on the Mail name.

Send mail at a specified time
You can specify the Date and Time you wish to send a mail message, and the mail will be sent at the
specific time . Simply click the Send ...message this session Now  box and click At, then it will
display the Time box to allow you to specify the time you would like to delivery this message . When
you click the Send Button, the Mail campaign will also be saved in your Outbox. It will be sent
automatically with the time that the message has reached the time you specified.

Auto Follow Up (Send Message with Send Rules)
This allows you to send auto follow up at a regular time automatically.  Simply click the Send
...message this session Now box and choose "Send Rules" option (you need to create a "Send Rule"
by clicking the 'New\Send Rules" button from the toolbar), then choose a send rule. Your message will
be sent depending on the rules you specify in the "Send Rules". Please click here for more information.

Send specified number of addresses per session
You can specify how many addresses you want to send for a mail campaign. For example, if your
mailing list contains 10000 email addresses, but you only want to send first 5000 this time, you can
simply enter the 5000 in the Send ...message this session box, so that the Mail Communicator will
only send first 5000 emails.

Following these settings are available for the formats you can use to specify the number of addresses
you would like  to send:

nnn: S end first nnn addresses in your mailing list and stop. For example, 5000
nnn-mmm: S kip first nnn addresses and send from nnn to mmm then stop. In this format, only the
addresses between nnn to mmm will be sent. For example, 5000 - 8000.
nnn : S kip first nnn addresses and sent from position nnn to the end. For example, 5001-

Send to a single email address :
You can type an single e-mail address in the To box to send a single message.  It works as your
normal email program.
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Open mail message from a file:
You can open a mail message from a file, click the File  menu and select Open Message, or click the
Open icon from the toolbar. In the "Select Message" dialog box, select the message from the template
list or open the message from a file in local folder.

Save message to a file :
You can also select the  File menu and select  Save Message As you would when you save a mail
message in your file system in text (.txt), or HTML (.htm) format.

Related Topics:
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

5.2 Save a Mail Campaign to send later

Save a Mail campaign to send later

You can save a draft of your mail campaign to work on or send it later.

To save a mail campaign, in the "Send Mail - New Mail" window, click the File menu and select  Save
to send later menu item. The mail will be saved in the Draft folder. You can open the mail campaign
later by double clicking on the Mail name.

Related Topics:
Creating a new Mail
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

5.3 Open a draft Mail Campaign

Open a draft mail campaign

If you have a mail campaign saved in the Draft folder, you can open the draft mail campaign to edit and
send.

1. Click the Message Draft tab on the Mail Communicator list box.
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2. On the Mail list box, click the name of Mail campaign .

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

5.4 Insert "Personalized" field to a Message

Insert "Personalized" field in a message

1. Load your mailing list file by clicking the Open Mailing List button next to the To box. Then the
Mailing List Header names will be added automatically to the "Insert Personalized Fields" box.

2. Click where you would like the "Personalized" field name to appear.

3. Click the Personalized Field box, and select the Field name you wish to insert.

Tips :
The Mailing List Header names will be added to the "Insert Personalized Fields" box automatically
after you specify the location of the mailing list file.

If your mailing list file does not contain any customized header field names, the program will
automatically use [Field1], [Field2] and so on for the "Personalized" field name. You can insert
[Field1], [Field2] ... to your message body, and it will be replaced with the data information from your
mailing list.

Use the "Preview" to quickly check your "Personalized" fields.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages
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5.5 Insert items in a message

5.5.1 Insert file attachment

Insert file attachments

To insert a file in a message

1. On the Send Mail window, click Insert menu, then click File Attachment. Or directly click the
"Attach" button on the toolbar.

2. Find the file you want to be attached.

3. Select the file, and then click Open. The file is listed in the Attach box in the message header.

Note
You can also add a text (*.txt) file into the body of your mail message by clicking the Insert menu and
then clicking Text from File.

Related Topics
Insert a picture
Insert a hyperlink or HTML page
Insert a HTML code

5.5.2 Insert a Picture

Insert a picture in a message

1. In the Send Mail window, click where you would like the image to appear.

2. On the Insert menu, click Picture, and type the location of your image into the Picture Source box
(please note the location is HTML souce code, not the local folder).

3. Enter Layout and Spacing information for the image file as needed.

Notes

·   If you cannot select the Picture command, make sure HTML formatting is turned on by clicking the
Format menu in the message window and then clicking Rich Text (HTML). A black dot appears by the
command when it is selected.

·   The picture must be stored on your web server. You must use a FULL URL address for the Picture
Source box. For example, http://www.mailcommunicator.com/images/mailcomm.gif. You can NOT
make a local copy of this image with your message.

More Info: please visit
http://www.dynamicwebcenter.com/knowledgebase/screenshot/mailcomm/insert_html.html

Related Topics
Insert an attachment
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Insert a hyperlink or HTML page
Insert a HTML code

5.5.3 Insert a Hyperlink or HTML page

Insert a hyperlink or HTML page

1. In the Send Mail window, click where you want to add the hyperlink or Web page text.

2. To add a hyperlink, click the Insert menu, and then click Hyperlink. Select the file type, and then
type the location or address of the link.

3. To add an HTML page, click the Insert menu, and then click Text from File. Change the Files type
box to HTML Files, and then find the file you want to add.

Tips
·   If you cannot select the Hyperlink menu command, make sure that the HTML formatting is turned
on by    clicking the Format menu in the message window and then Selecting a Rich Text (HTML).
And then tick the mark that appears by the command when it is selected.

·   To create a hyperlink from message text, simply select the text before you create the hyperlink.

Related Topics
Insert an attachment
Insert a picture
Insert a HTML code

5.5.4 Insert HTML Code

Insert HTML Code

1. In the Send Mail window, click where you want to add the hyperlink or Web page text.

2. To add a hyperlink, click the Insert menu, and then click HTML Code. Select the file type, and then
type the location or address of the link.

3. Type the HTML code into the HTML code box, and click OK .

Tips
·   If you cannot select the Hyperlink menu command, make sure that HTML formatting is turned on by
clicking the Format  menu in the message window and then select Rich Text (HTML). A selection tick
mark appears, by the command when it is selected.

·   You can also add / edit HTML directly to the message by clicking the Source tab on the Message
box.

Related Topics
Insert an attachment
Insert a picture
Insert a hyperlink or HTML page
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6 Formatting Message Text

Formatting message text

When you want to add special emphasis or structure to a message text:such as bold, color, or bulleted
lists, you can use Hypertext Markup Language (HTML) message format. Using HTML formatting also
enables you to add graphics and links to Web sites in your messages.

When you use HTML formatting and the recipient's mail program does not read HTML, the message
appears as plain text with an HTML file attached. Only e-mail programs that support MIME
(Multipurpose Internet Mail Extensions) can read HTML formatting.

Related Topic:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

7 Understand Message Format

Understand Message Format

Mail Communicator supports both HTML (Rich Text) and Plain Text file format. You can specify the
default format under the "File/Configuration" window.

When you create messages using HTML formatting, only mail programs that support HTML can read
the formatting. If the recipient's mail program does not read HTML, the message will be displayed as
plain text with an HTML file attached.

You can also choose to send the the Email using HTML format only. This option is good to reduce the
size of the email, however, if the recipient's mail program does not read HTML, the message will not
available for viewing.

To use HTML formatting

In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML).

Notes
To edit the HTML source tags, click the Source tab and start editing.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
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Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

8 Creating a Pre-formatted Customized Message

Create a Pre-formatted customized message

This feature will allow you to pre-format your message and make your email much more personal (so
called "Personalized " Email ) . By sending "Personalized " email message in this way, your message
will look like to be sent for each individual recipient only. The recipient will think that the message were
sent for him / her personally and not from a bulk emailing list, you will experience a much better
response to your email messages sent using this feature.

To do this, you need to first know the number of fields in your mailing list and the  field name. For
example, if your mailing list has 3 fields: email address, name and company name as below:

[NAME], [EMAIL], [COMPANY]
david@apexpacific.com, Peter Laurent, eDynamicSoft
........

then you can insert the field name [EMAIL], [NAME] or [COMPANY] into anywhere of the body of your
message or the Subject line. Every time the program sees this control charactor [NAME], [EMAIL] or
[COMPANY] it will replace the control character with the value from your email list (from the 'name' or
'email' field).

For example (please compare the text in RED font color carefully):

Your mailing List looks like this:
[NAME], [EMAIL], [COMPANY]
<success@newnet.com>, Peter Laurent, eDynamicSoft
........

Your original message looks like this:

Dear [NAME],

Thank you for joining our mailing list. I just want to confirm your subscribe information as below:
Email: [EMAIL]
Name: [NAME]
Company: [COMPANY]

...........(etc)

Email message received by the recipient will looks like this:

Dear Peter Laurent,

Thank you for joining our mailing list. I just want to confirm your subscribe information as below:
Email: success@newnet.com
Name: Peter Laurent
Company: eDynamicSoft

...........(etc)
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As you can see from above, the personalized fields([Email], [Name] and [Company]) you have entered
in the message has been replaced with the data information from your mailing list. Each message will
looks like to be sent for each individual recipient only.

Note : The first line of your mailing list file normally is the field name. However, this is only an option. If
your mailing list file does not contain a field name, the program will use [Field1], [Field2] ... as a field
name for each column in your mailing list.

For example, your mailing list file does not contain a field name. Your mailing List file looks like this:

<success@newnet.com>, Peter Laurent, eDynamicSoft
........

Your original message looks like this:

Dear [FIELD2],

Thank you for joining our mailing list. I just want to confirm your subscribe information as below:
Email: [FIELD1]
Name: [FIELD2]
Company: [FIELD3]

...........(etc)

Email message received by the recipient will looks like this:

Dear Peter Laurent,

Thank you for joining our mailing list. I just want to confirm your subscribed information as below:
Email: success@newnet.com
Name: Peter Laurent
Company: eDynamicSoft

...........(etc)

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

9 Change the Priority of an Outgoing Mail Message

Change the priority of an outgoing mail message

When you send a new message or reply to a message, you can assign the message a priority so the
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recipient knows to either look at it right away (High Priority) or to read it when time permits (Low
Priority).

·A  High priority  message has an exclamation point next to it

·A  Low priority  is indicated by a down arrow.

In the New Message window, click the Priority button on the toolbar, and then select the priority you
would like. Or, click the Message menu, point to Set Priority, and then select the priority option.

Note
This setting assigns the priority only for the current message.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Requesting read reciept for sent messages

10 Requesting Read Receipt for Sent Message

Requesting read receipt for sent messages

To be notified when your outgoing messages are received.

You can set up Mail Communicator to receive a receipt for the email you send. The receipt is sent
when the message recipient has displayed your message. This is useful when you want confirmation
that your message has been delivered.

To request a read receipt for messages, click the Tools menu in the Send Mail  window, and then click
Request Read Receipt.

Note
Message recipients can choose not to send read receipts, even when they are requested.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
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11 Viewing and Receiving Mail Message

11.1 Receiving message from mail server

Receiving messages from mail server

1. Click the Incoming Email tab the Mail Communicator.

2. Select a mail account on the Mail Account list box.

3. Click the Get Msg button on the Toolbar.

Note:
Once the messages have been retrieved from your mail server, the messages are still stored in your
mail server. You can delete the messages permanently by selecting the messages you want to delete,
and click the Delete button on the toolbar.

We suggest that you use this facility in conjunction with your normal email reader software. You can
check your mail server at any time for new messages and reply to them if you wish. Then delete any
messages you don't want to read, and view the remaining messages with your email reader program.

Tips:
·   You can reply to a message by selecting a message, and clicking the Reply button on the toolbar.

·   You can also reply to all messages by selecting all the messages, and clicking the Reply All button
on the toolbar. This function allows you to send a message to all the people in your mailbox.

·   You can add a sender's email address to a mailing list file, by selecting the messages you would like
to add and then Select the Add To Mailing List  button on the toolbar.

Related Topics:
Download Message headers only
Get Returned (undeliverable) Email addresses
Subscribe and Un-subscribe to a Mailing List
Processing message with Message Rules

11.2 Download Message Headers Only

Download Message Headers Only

1. Click the Incoming Email tab the Mail Communicator.

2. Select a mail account on the Mail Account list box.

3. Click the Header button on the toolbar .

Note:
This function will only retrieve message headers from your mail server, the messages that are still
stored on your mail server. You can delete the messages from your mail server permanently by
selecting the messages you want to delete, and select the Delete button on the toolbar.

This function provides you a powerful feature to view a list of the messages in your mailbox before they
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are downloaded onto your PC. It can be used to delete mail bombs,  junk emails and the emails that
contains viruses.

We suggest that you use this facility in conjunction with your normal email reader software. You can
check your mail server at any time for new messages and reply to them if you wish. Then delete any
messages that you don't want to read, and view the remaining messages with your email reader
program.

Tips:
·   You can reply a message by selecting a message, and clicking the Reply button on the toolbar.

·   You can also reply to the sender, including the CC recipient by selecting the email, and clicking the
Reply All button  on the toolbar. This function allows you to reply to the sender of the email and also
all the CC (carbon copy recipient)..

·   You can add sender's email address to a mailing list file, by selecting the messages you want to add
and clicking the Add To Mailing List button on the toolbar.

Related Topics:
Receiving message from mail server
Get Returned (undeliverable) Email addresses
Subscribe and Un-subscribe to a Mailing List
Processing message with Message Rules

11.3 Get Returned (un-deliverable/bounced back) Email Addresses

Remove Returned (un-deliverable) Email Addresses automatically

This is a powerful function which allows you to retrieve the email address of the unsuccessful (un-
delivered) emails. When sending a large bulk email campaign to thousands of people, there are always
undelievered emails that will bounce back. To get a returned email address and add them to the
Removed mailing list manually is very difficult and time consuming.

This function provides you a way to add returned email addresses to your master Removed Mailing list
AUTOMATICALLY, so that you can remove the un-deliverable email addresses from your mailing list
and don't send it again next time.

To retrieve returned (un-delivered) email address:

1. Click the Mail Account folder item on the Mail Communicator folder list.

2. Click a mail account on the mail account list.

3. Go to Tools item in the menu bar, and select Get Returned Email Address menu item.

Tips:
You can add returned email addresses to the master Removed Mailing list automatically. Please click
the File/Configuration menu item from the menu bar. In the "General" tab of Configuration setup
window, always check the box Always add undelieverable email address to the master Removed
Mailing list file. You can also check the box delete the message from server after added to the
removed file .

Related Topics:
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Receiving message from mail server
Download Message headers only
Subscribe and Un-subscribe to a Mailing List
Processing message with Message Rules

11.4 Subscribe and Un-Subscribe to a Mailing List

Subscribe and Unsubscribe to a Mailing List

This function of Mail Communicator allows you to subscribe or unsubscribe your clients from your
mailing list.

Each Mail Account has a Mailing List file attached to it. This mailing list will automatically has a default
subscribe or unsubscribe rule attached to that mail account.

The default "Subscribe" rule is that if the incoming email's Subject contains "Subscribe", the program
will add the incoming mail's email address to the Mailing List.
The default "Unsubscribe" rule is that if the incoming email's Subject contains "Remove" or
"unsubscribe", the program will remove the incoming mail's email address from the Mailing List.

Tips :
You can also use Message Rules to provide more complicated functions and actions.

Related Topics:
Add a mail account
Receiving message from mail server
Download Message headers only
Get Returned(undeliverable) Email addresses
Processing message with Message Rules

12 Message Rules Set-Up

12.1 Incoming Message Rule

12.1.1 Incoming Message Rule

Incoming Message Rule

It is a powerful function allowing you to process mail messages automatically with the message rules. It
works like an auto-responder (Receive Mail Rule), you can use rules in Mail Communicator to
automatically "reply to" or forward certain messages, send a specified message to a mailing list, add or
remove a sender from a mailing list (the same as subscribe and un-subscribe), or run an external
program.

Go to "File/New/Receive Mail Rule" item from the menu bar. Or click "Mailing Rules" in the tab, then
click "New" icon on the tool bar then select "Incoming Mail Rule". The "Message Rule" screen will show
up.

There are 9 types of actions you can set up with the Receive Mail Rule:

Reply with message
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Add Sender to mailing list

Remove Sender from mailing list

Forward to people in the mailing list

Delete it from the server

Send message to people in the mailing list

Run External Program

Process Web Form with mailing list

Send Message to people in Web Form

Related Topics:
Create a rule for mail messages
Processing Message with Message Rules
Apply a rule to incoming messages
Change a rule

12.1.2 Create Incoming Message Rule

Create a rule for mail messages

1. On the File menu, select New menu item, and then select Message Rules. (Or select Message
Rules item from the Mail Communicator list box and click the New button on the Toolbar).

2. Select the conditions for your rule by selecting the desired check boxes in the Conditions section.

You can specify multiple conditions for a single rule by clicking more than one check box. Click the
And / Or  radio button under the Rule Description section to specify whether all of the rule conditions
apply before the specified action occurs (and) or whether at least one must be met (or).

3. Select the actions for your rule by selecting the desired check boxes in the "Actions" menu. There
are 8 types of actions you can choose from. (You must select at least one condition). Please see
Processing Message with Message Rules for details on 8 types of actions.

4. Double-click the description text in the Rule Description section to specify the conditions or actions
for your rule.

5. You can select words in the Rule Description section to specify the words you'd like the Mail
Communicator to look for in messages.

6. In the Name of the rule box, type a new name for your rule, and then click OK .

Note: If you don't select any condition but you have assigned an action, then the action will apply to all
messages.

Related Topics:
What is a Message Rule?
Apply a rule to incoming messages
Change a rule
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Processing Message with Message Rules

12.1.3 Reply with a Message

Reply with Message

This action replies the message with a specified message. Eg, auto-responders.

In the "Message Rule" window, check the box "Reply with message" in "No. 2 Select the actions for
your rule", and select the message from the given list.

Related Topic:
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
Process Web Form with Mailing List

12.1.4 Add Sender to Mailing List

Add Sender to a Mailing List

It adds an email address of the sender to a specified mailing list. For example, you can add your
subscriber's email address to your newsletter mailing list if the subject line contains the word
"subscribe".

In the "Message Rule" window, check the box "Add Sender to a Mailing List" in "No. 2 Select the
actions for your rule", and select the mailing list where the sender will be added in.

Related Topics:
Reply with Message
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
Process Web Form with Mailing List

12.1.5 Remove Sender from Mailing List

Remove Sender from Mailing List

It removes an email address of a sender from a mailing list. For example, you can use it as a "un-
subscribe"  function to remove your clients email address from your mailing list if the Subject line
contains the word "unsubscribe".

In the "Message Rule" window, check the box "Remove Sender from Mailing List" in "No. 2 Select the
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actions for your rule", and select a mailing list where the sender will be removed.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
Process Web Form with Mailing List

12.1.6 Forward to People in Mailing List

Forward Mail to People in Mailing List

This action forwards original emails to a specified mailing list.

In the "Message Rule" window, check the box "Forward Mail to People in Mailing List" in "No. 2 Select
the actions for your rule", and select a mailing list where messages will be forwarded to.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
Process Web Form with Mailing List

12.1.7 Delete from Mail Server

Delete Mail from Server

This action deletes the message from your mail server with conditions set up early on.

It is used to delete any selected messages which you don't want to read. This facility is very useful if
you receive a mail bomb. It allows you to delete an unwanted message from your mail server directly
without the need for downloading it to your PC.

In the "Message Rule" window, check the box "Delete Mail from Server" in "No. 2 Select the actions for
your rule", to delete the selected messages.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Send Message to people in the Mailing List
Run an External Program
Process Web Form with Mailing List



Message Rules Set-Up 68

©2009 Apex Pacific Pty. Ltd.

12.1.8 Send Message to People in Mailing List

Send Message to people in the Mailing List

It sends a specified pre-designed message to a specified mailing list.

In the "Message Rule" window, check the box "Send Message to People in Mailing List" in "No. 2
Select the actions for your rule", and select the message template and mailing list from the list given.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Run an External Program
Process Web Form with Mailing List

12.1.9 Process Web Form with Mailing List

Process Web Form with Mailing List

It allows you to process web form data and retrieve the information from your Web Form and add it to a
mailing list file.
For example, here is an example of Web Form:

Client David Peter (davidpeter@apexpacific.com) submitted following on 8/13/2002 1:39:23 AM :
-----------------------------------------------------
Site : API
Name : David Peter
email : davidpeter@apexpacific.com
Address : 6-8 Create Place
City : Rosebery
State : NSW
Postcode : 2000
Country : Australia
-----------------------------------------------------

The program will retrieve the above information and save it into the mailing list file you specified in
following format:

API, David Peter, davidpeter@apexpacific.com, 6-8 Create Place, Rosebery, NSW, 2000, Australia
......

So that you can use it directly with Mail Communicator to send "personalized" emails, or process it with
other program.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
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12.1.10 Run an External Program

Run an External Program

It runs an external program.

In the "Message Rule" window, check the box "Run an External Program" in "No. 2 Select the actions
for your rule", and select the program by browsing your local folder.

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Process Web Form with Mailing List

12.1.11 Send Message to people in Web Form

Send Message to people in Web Form

This function allows you to reply a message to an email address in the web form. For example, here is
a sample of Web Form:

-----------------------------------------------------
Site : API
Name : David Peter
email : davidpeter@apexpacific.com
Address : 6-8 Create Place
City : Rosebery
State : NSW
Postcode : 2000
Country : Australia
-----------------------------------------------------

With this action, you can send a message to the email address davidpeter@apexpacific.com.
Note: you must use the field name EXACTLY as "Email:"

Related Topics:
Reply with Message
Add Sender to a Mailing List
Remove Sender from Mailing List
Forward Mail to People in Mailing List
Delete Mail from Server
Send Message to people in the Mailing List
Run an External Program
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12.2 Send Message Rule

Send Message Rule

Send mail rule allows you to create condition based email campaigns. For example, you can create a
recurring email campaigns that will send automatically every week or month.

Go to "File/New/New Send Rule" item from the menu bar. Or click "Mailing Rules" in the tab, then click
"New" icon on the tool bar then select "Send Mail Rule". The "Message Rule" screen will show up.

Actions explanation:

Send Message: Once the condition has been met, the message will be sent to the email address with
the [Date] field that is 3 days old.

Remove email address from mailing list: Once the condition has been met, the email address will be
deleted from the Mailing List that was used on the Mail Campaign that applies this rule.

Move email address to <Mailing List>: Once the condition has been met, the email address will be
moved to the specificed Mailing List (when you tick the box, you can specify which Mailing List you
wish to move the email address to).
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13 Process Message with Message Rules

Processing Message with Message Rules

This is a powerful function that allows you to process mail messages automatically with the message
rules. It works like an auto-responder, so you can use rules in Mail Communicator to automatically
reply to or forward certain messages, send a specified message to a mailing list, add or remove a
sender from a mailing list (the same as subscribe and un-subscribe), or run an external program.

Go to "File/New/Rule" item from the menu bar. Or click "Message Rules" in the folder list, then click the
"New" icon on the tool bar. The "Message Rule" screen will show up.

1. Select the condition for your rule.

You have 8 options to choose for either containing or not containing specific words. Select the option
and check the box and you will see the dialog box of "Type Specific Word". Type the word or phrase,
then click "Add" button the right side. Repeat the same steps to add more words based on condition
you want to set up.
Click the word in the list and click "Remove" button on the right hand side to delete the word.
Click "OK" button after you finish all the above steps. Now the condition is set up.

2. Select the actions for your rule.

There are 8 types of actions you can choose to set up your message rule.
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·   Reply with message
It replies the message with a specified message. Eg, auto-responders.
Check the box and select the message from the given list.

·   Add Sender to mailing list
It adds an email address of the sender to a specified mailing list. For example, you can add your
subscriber's email address to your newsletter mailing list if the subject line contains the word
"subscribe".
Check the box and selelct the mailing list where the sender will be added in.

·   Remove Sender from mailing list
It removes an email address of a sender from a mailing list. For example, you can use it as a "un-
subscribe"  function to remove your clients email address from your mailing list if the Subject line
contains the word "unsubscribe".
Check the box and selelct a mailing list where the sender will be removed.

·   Forward it to people in the mailing list
It forwards original emails to a specified mailing list.
Check the box and select a mailing list where messages will be forwarded to.

·   Delete it from the server
It deletes the message with conditions set up in Step 1.

·   Send message to people in the mailing list
It sends a specified pre-designed message to a specified mailing list.

·   Run External Program
It  runs an external program. Check the box and select the program by browsing your local folder.

·   Process Web Form with mailing list
It allows you to process web form data and retrieve the information from your Web Form and add to a
mailing list file.
For example, here is a sample of Web Form:

Client David Peter (davidpeter@apexpacific.com) submitted following on 8/13/2002 1:39:23 AM :
-----------------------------------------------------
Site : API
Name : David Peter
email : davidpeter@apexpacific.com
Address : 6-8 Create Place
City : Rosebery
State : NSW
Postcode : 2000
Country : Australia
-----------------------------------------------------

The prgoram will retrieve above information and save it into the mailing list file you specified in
following format:

API, David Peter, davidpeter@apexpacific.com, 6-8 Create Place, Rosebery, NSW, 2000, Australia
......

So that you can use it directly with Mail Communicator to send "personalized" emails, or process it with
another program.

·Send <message> to people in the Web Form
This function allows you to reply a message to an email address in the web form. For example, here is
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a sample of Web Form:

-----------------------------------------------------
Site : API
Name : David Peter
email : davidpeter@apexpacific.com
Address : 6-8 Create Place
City : Rosebery
State : NSW
Postcode : 2000
Country : Australia
-----------------------------------------------------

With this action, you can send a message to the email address davidpeter@apexpacific.com.
Note: you must use the field name EXACTLY as "Email:"

3. Rule Description

Once you finish Step 1 and 2, the rules set up by you will be automaticaly shown in the box. Double-
click the description text in the Rule Description section to specify the conditions or actions for your
rule. In the Rule Description section you can specify the words you'd like the Mail Communicator to
look for in messages.

4. Name of the Rule

Give a name of the rule you just set up so that you can identify it in the list of Mail Rules.

Related Topics:
What is a Message Rule?
Create a rule for mail messages
Apply a rule to incoming messages
Change a rule

14 Apply a Rule to Incoming Messages

Apply a Message Rule to incoming messages

The rules you have created will be applied to a mail account.

1. By Selecting the Mail Account item from the Mail Communicator list box, double click an Account
name from the Mail Account list box.

2. In the Mail Account dialog box, click the "Message Rules" tab.

3. Select the rules you want to apply for a message to this account, or click Select All to select all the
current rules.

Related Topics:
What is a Message Rule?
Create a rule for mail messages
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Change a rule
Processing Message with Message Rules

15 Change a Rule

To change a rule

1. Select Mailing Rules tab from the Mail Communicator main window.

2. Double click on the Rule's name from the Rules list box.

3. Make your changes in the Message Rule dialog box, including the Re-naming name, then select
OK.

Related Topics:
What is a Message Rule?
Create a rule for mail messages
Apply a rule to incoming messages
Processing Message with Message Rules

16 Managing Mail Account

16.1 Create a new Mail Account

Remove Returned (un-deliverable) Email Addresses automatically

This is a powerful function which allows you to retrieve the email address of the unsuccessful (un-
delivered) emails. When sending a large bulk email campaign to thousands of people, there are always
undelievered emails that will bounce back. To get a returned email address and add them to the
Removed mailing list manually is very difficult and time consuming.

This function provides you a way to add returned email addresses to your master Removed Mailing list
AUTOMATICALLY, so that you can remove the un-deliverable email addresses from your mailing list
and don't send it again next time.

To retrieve returned (un-delivered) email address:

1. Click the Mail Account folder item on the Mail Communicator folder list.

2. Click a mail account on the mail account list.

3. Go to Tools item in the menu bar, and select Get Returned Email Address menu item.

Tips:
You can add returned email addresses to the master Removed Mailing list automatically. Please click
the File/Configuration menu item from the menu bar. In the "General" tab of Configuration setup
window, always check the box Always add undelieverable email address to the master Removed
Mailing list file. You can also check the box delete the message from server after added to the
removed file .
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Related Topics:
Receiving message from mail server
Download Message headers only
Subscribe and Un-subscribe to a Mailing List
Processing message with Message Rules

16.2 Change Settings on an Existing Mail Account

Change settings of an existing mail account

1. Click the Mail Account tab from the Mail Communicator main window.

2. On the Mail Account list, double click on an account.

3. Change the information as needed on the appropriate tabs.

·   General
Enter the name of new mail account, then the user information with the name of the user, name of
organization, email address and reply address.

·   Servers
Server information, Incoming mail server and Outgoing mail server.

·   Message Rules
Check the box to select the message rules you have created. For how to create or set-up a new
message rule, please see Processing Message with Massage Rules.

·   Advance
You can set up the Server timeouts, Incoming mail server, Outgoing mail server and subscribe mailing
list.

Related Topic:
Add a mail account
Processing Message with Massage Rules

17 Managing Mailing List

17.1 Create a new Mailing List

17.1.1 General Guide on Creating New Mailing List

Change settings of an existing mail account

1. Click the Mail Account tab from the Mail Communicator main window.

2. On the Mail Account list, double click on an account.

3. Change the information as needed on the appropriate tabs.

·   General
Enter the name of new mail account, then the user information with the name of the user, name of
organization, email address and reply address.
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·   Servers
Server information, Incoming mail server and Outgoing mail server.

·   Message Rules
Check the box to select the message rules you have created. For how to create or set-up a new
message rule, please see Processing Message with Massage Rules.

·   Advance
You can set up the Server timeouts, Incoming mail server, Outgoing mail server and subscribe mailing
list.

Related Topic:
Add a mail account
Processing Message with Massage Rules

17.1.2 Create a Mailing List in Mailing List Editor

Create a Mailing list in Mailing List Editor
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On the File menu, Select New and then select Mailing List. (Or on the toolbar, click New from the
drop down menu button, and select  Create New Mailing List).

Step 1
When you are in the "Mailing List Wizard" screen, select the option of "Create a mailing list in mailing
list Editor", then click the "Next" button at the bottom to go to next stage.

Step 2
Select the items from the list by checking the box. You can rearrange the order by using "Moving Up"
and "Moving Down" buttons on the right side.
If you can't find the item you want in the list, simply enter the name of the item in the box and click
"Add" button.

Step 3
Click "Next" button at the bottom to go to Step 3.  Enter the name and description of your mailing list
and save it to local folder by using "Browse" button.

Step 4
Click the "Next" button at the bottom to go to Step 4.  Then click the "Finish" button at the bottom. It
than goes to "Mailing List Editor" screen for you to view the newly created mailing list or edit it. See
"Mailing List Editor" on how to edit your existing mailing list.

Tip:

You can De-duplicate the List by clicking the "De-duplicate" button on the toolbar. This will remove any
duplicated email address from the list.

Related Topics:
Import External File to create Mailing List
Open an existing Mailing List
Enter or Edit mailing list data manually
Mailing List File format
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List

17.1.3 Import External File/Database to Create a Mailing List

Creating a Mailing List using an Existing Data Source

This wizard will take you to setup a new Mailing List using an external data source as the basis. This is
a useful feature to help you import your existing mailing list.

Step 1 - Select the option: I already have a data source, I want to Import my contact list from my
existing data source.
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Step 2 - You can import from selected range of data source Text file, Access database (2003 and
before), Outlook, Excel (2003 and before) and XML format files. You can also choose the delimiter for
multiple fielded data sources (normally text sources).
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Step 3 - If you selected the Text file as your data source, you will see the sample data to make sure it
is the correct format.
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Step 4 - You will need to specify the name, description and location for your new mailing list.
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Step 6 - This is the last page, hit "Finish" to create the mailing list.

Tips :

·   You can also  import multiple fields such as your name, company name , and your address to your
mailing list file, so that you can send "Personalized" messages with the Send Mail function.

·   You can import email addresses from an existing mailing list file or MS Access Database file. When
importing a mailing list file, you can also select which field you wish to include into the new mailing list.

Related Topics:
Create Mailing List in Mailing List Editor
Open an existing Mailing List
Enter or Edit mailing list data manually
Mailing List File format
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List
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18 Open an existing Mailing List

Open an existing Mailing List

1. Click the Mailing List Tab on the Mail Communicator main window.

2. On the Mailing list folder, double-click on the mailing list item.

Related Topic:
Creating a new mailing List
   - Create Mailing List in Mailing List Editor
   - Import External File to create Mailing List
Enter or Edit mailing list data manually
Mailing List File format
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List

19 Enter or Edit mailing list data manually

Enter or Edit mailing list data manually

To edit or enter mailing list data manually, please follow the instructions below:

1. Select the cell you want to edit, and press the "Space" bar or double click on the cell to enter into the
Edit mode.
2. Press the "Enter" key to move to the next cell.
3. Press the "Space" bar to enter to the Edit mode and repeat this step again.

Related Topics:
Creating a Mailing List
   - Create Mailing List in Mailing List Editor
   - Import External File to create Mailing List
Open an existing Mailing List
Mailing List File format
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List

20 Mailing List Format

Mailing List File format

You can send emails from a plain text mailing list file, MS Access, SQL or MS Outlook address or
folder. Your mailing list may contain multiple fields. The following are some samples to show you how a
plain text mailing list file looks like.

A plain ASCII text file format is a common mailing list format for many bulk email program. It expects a
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plain text file with one email address on a seperate line as follows:

   [Email]
   friends@sample-email.com
   Email Marketing <friends@sample-email.com>
   <friends@sample-email.com> "Money make"
   ..........

Note: All of the above formats are correct email address format for Mail Communicator.

Your mailing list can also contain multiple fields seperated by a comma as seen below :

   [Email], [Name], [Company]
   peter@edynamicsoft.com, Peter Laurent, eDynamicSoft
   david@apexpacific.com, David Liang, Apex Pacific
   .......

Tips:
·   Email address field can be at any column. The following mailing list format is also supported by Mail
Communicator.

   [Name], [Email], [Company]
   Peter Laurent, peter@edynamicsoft.com, eDynamicSoft
   David Liang, david@apexpacific.com, Apex Pacific
   .......

Mailing List Header Field (for example: [Email], [Name] etc) is an option. If your mailing list file does
not include any header field, it still works with the Mail Communicator. But we suggest that you Create
a New Mailing List function to import your existing mailing list file to the Mail Communicator format. For
example:

   friends@sample-email.com
   Email Marketing <friends@sample-email.com>
   <friends@sample-email.com> "Money make"
   ..........

   or

   peter@edynamicsoft.com, Peter Laurent, eDynamicSoft
   david@apexpacific.com, David Liang, Apex Pacific
   .......

If your mailing list is stored in a database or another file format, you can export your mailing list from
the above format and that is used by Mail Communicator. See related topic below for more information.

Related Topics:
Creating a Mailing List
   - Create Mailing List in Mailing List Editor
   - Import External File to create Mailing List
Open an existing Mailing List
Enter or Edit mailing list data manually
Convert MS Access Database file to plain text file format
Insert "Personalized" field in a message
Managing Mailing List
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21 Convert MS Access Database File to Plain Text File
Format

Convert MS Access Database file to a plain text file format

If your email address is stored in MS Access Database, you can convert it to plain text from the file
format which is supported by Mail Communicator.

1. Click the New button on the toolbar, and click Create New Mailing List.

2. In the Mailing List Wizard dialog box, I already have a data source, I want to Import my contact list
from my existing data source, then click Next  .

3. Click the Import From box and then click Access Database.

4. Click the Browse button to locate the imported database file, and then click Next  .

5. Select a Table Name that contains an email address from the table list, and then click Next.

6. Select the fields you would like to include in the New Mailing List File and click Next.

Related Topics:
Creating a Mailing List
   - Create Mailing List in Mailing List Editor
   - Import External File to create Mailing List
Open an existing Mailing List
Enter or Edit mailing list data manually
Mailing List File format
Insert "Personalized" field in a message
Manage Mailing List

22 Insert Personalized Field in a Message

Insert "Personalized" field in a message

1. Load your mailing list file by clicking the Open Mailing List button next to the To box. Then the
Mailing List Header names will be added automatically to the "Insert Personalized Fields" box.

2. Click where you would like the "Personalized" field name to appear.

3. Click the Personalized Field box, and select the Field name you wish to insert.

Tips :
The Mailing List Header names will be added to the "Insert Personalized Fields" box automatically
after you specify the location of the mailing list file.

If your mailing list file does not contain any customized header field names, the program will
automatically use [Field1], [Field2] and so on for the "Personalized" field name. You can insert
[Field1], [Field2] ... to your message body, and it will be replaced with the data information from your
mailing list.

Use the "Preview" to quickly check your "Personalized" fields.
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Related Topics:
Creating a new Mail
Save Mail campaign to send later
Open a draft mail campaign
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages

23 Mailing List Tools

23.1 Overview on Mailing List Tools

Mailing List Tools

Mailing List tools allow you to process your mailing list in an easy way to meet your requests. Mail
Communicator provides the following utilities to help you to manage your mailing list.

   Sort and De-duplicate email addresses

   Remove email addresses

   Merge mailing list

   Split mailing list

   Retrieve email address from file or mail folder

Related Topic:
Mailing List file format



Mailing List Tools 86

©2009 Apex Pacific Pty. Ltd.

23.2 Sort and De-duplicate email addresses

Sort and De-duplicate email addresses

The Sort / De-duplicate function allows you to sort and remove duplicates from your mailing lists. The
mailing list file must be in plain ACSII format, with one email address on a seperate line.

To start sort and de-duplicate email addresses:
1. Click the Tools menu, and click Sort / De-duplicate.

2. In the Mailing List Tools  window, click the Add button to add the mailing list to be sorted and de-
duplicated.

3. Click the Browse button to specify the location of the Output file, then click Start  button.

Tips :
·   You can add as many files as you like by pressing the Add button and locating a file.
·   Click the Remove button to remove the selected file from the sort file list.
·   Final output sorted file - This is where the final addresses will be stored after sorting and de-
duplicating and merged.

Related Topics:
Overview on Mailing List Tools
Sort and De-duplicate email addresses
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Remove email addresses
Merge mailing list
Split mailing list
Retrieve email address from file or mail folder
Count email addresses in a mailing list

23.3 Remove email addresses

Remove email addresses

This function allows you to run one file (Normally Remove file) against another (Normally Mailing List
file) and write a third "clean" file (New Mailing List file) which contains only entries that were in the List
file but were not found in the Remove file.

1. Click the Tools  menu, and click Remove.

2. In the Mailing List Tools  window, click the Browse button to specify the mailing list file, you want
to remove.

3. Click the Add button to add the mailing list to be removed.

4. Click the Browse button to specify the location of the Output file, and then select the Start button.

Tips :
This can be used for more than just processing new address lists against the remove lists. Let's say
you have a list of 10,000 addresses that you have already used and then you receive a new list of
50,000. You may not want to send a message, if a duplicate address is in BOTH lists. These recipient's
might not appreciate receiving the same message twice, so here is what you do: Put the new 50,000
list in the Mailing List File to remove box, put your original 10,000 list in the Remove File list box, and
make up a new name for the New Output List File. Then Select  Start. The New Output List file will only
contain the addresses that you have not used before.

Related Topics:
Sort and De-duplicate email addresses
Merge Mailing List
Split Mailing List
Retrieve Returned Email Addresses
Retrieval Email address from file or mail folder
Count email addresses in a mailing list

23.4 Merge Mailing List

Merge Mailing List

This utility will allow you to merge several mailing list files into a single list file.

1. Click the Tools menu, and click Merge.

2. In the Mailing List Tools window, click the Add button to add the mailing list file to be merged.

3. Click the Browse button to specify the location of the Output file, then select the Start button.

Tips:
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The Remove button will remove a file from the merge files list.

Related Topics:
Sort and De-duplicate email addresses
Remove email addresses
Split Mailing List
Retrieve Returned Email Addresses
Retrieval Email address from file or mail folder
Count email addresses in a mailing list

23.5 Split Mailing List

Split Mailing List

This utility will allow you to split a mailing list file in to several smaller mailing list file.

1. Click the Tools menu, and click Split.

2. In the Mailing List Tools window, click the Browse button to specify the mailing list file you would
like to split.

3. Enter the number of email addresses per file, and the base name of the output file, then click the
Start button.

Tips:
Base name of the output will be used to generated the output mailing list file. For example, by default,
the Base name of output file is "spliter", then program will use file name "spliter1.txt", "spliter2.txt",
"spliter3.txt" .... and so on to generated the output mailing list file.

Related Topics:
Sort and De-duplicate email addresses
Remove email addresses
Merge Mailing List
Retrieve Returned Email Addresses
Retrieval Email address from file or mail folder
Count email addresses in a mailing list

23.6 Retrieving email addresses from file or mail folder

Retrieve Email address from a file or mail folder

This function allows you to retrieve email address from a file or email folder file.

1. Click the Tools menu, and then Retrieve.

2. In the Mailing List Tools window, click the Browse button to locate the file you want to retrieve the
email address from.

3. Select the file type.
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4. Click the Browse button to specify the location of the Output file, and then click the Start button.

Tips:

Retrieve from an Email Folder File - This option is used to retrieve email addresses from your
normal email folder file such as Outlook Express, Netscape, Eudora, etc. You can specify which field
you want to retrieve the email address from. For example, "From" field, or "Reply-To" field or both.

For example, if you use Outlook Express as your normal email reader program, and you have a folder
named "Junk Mail"  which contains all the junk emails in your mailbox, you can use this option to
create a mailing list from this "Junk Mail" folder.

For Outlook Express, the Email Folder file is located at following directory:
C:\WINDOWS\Application Data\Microsoft\Outlook Express\Mail and the file name with an extension
name .mbx .

Retrieve from HTML file - This option is used to retrieve email addresses from a HTML file that
contains email addresses.

Encoded with in <...>  - This option is used to retrieve email addresses that encoded with in the <...>
mark.

Separated by a Comma - This option is used to create a mailing list from a ASCII file in which each
address is seperated by a comma, the original ASCII file should have the following format:
friends@public.com, <people@anywhere.com>, business@makingmoney.com...

Related Topics:
Sort and De-duplicate email addresses
Remove email addresses
Merge Mailing List
Split Mailing List
Retrieve Returned Email Addresses
Count email addresses in a mailing list

23.7 Counting email addresses in a mailing list

Count email addresses in a mailing list

This function allows you to count the number of email addresses in a mailing list file.

1. Click the Tools menu, and then click Count.

2. In the Mailing List Tools window, click the Browse button to locate the mailing list you would like to
count, and click the Start button.

Related Topics:
Sort and De-duplicate email addresses
Remove email addresses
Merge Mailing List
Split Mailing List
Retrieve Returned Email Addresses
Retrieval Email address from file or mail folder
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24 Managing Message Template

24.1 Create a new Message Template

Change settings of an existing mail account

1. Click the Mail Account tab from the Mail Communicator main window.

2. On the Mail Account list, double click on an account.

3. Change the information as needed on the appropriate tabs.

·   General
Enter the name of new mail account, then the user information with the name of the user, name of
organization, email address and reply address.

·   Servers
Server information, Incoming mail server and Outgoing mail server.

·   Message Rules
Check the box to select the message rules you have created. For how to create or set-up a new
message rule, please see Processing Message with Massage Rules.

·   Advance
You can set up the Server timeouts, Incoming mail server, Outgoing mail server and subscribe mailing
list.

Related Topic:
Add a mail account
Processing Message with Massage Rules

24.2 Open an existing Message Template

Open a draft mail campaign

If you have a mail campaign saved in the Draft folder, you can open the draft mail campaign to edit and
send.

1. Click the Message Draft tab on the Mail Communicator list box.

2. On the Mail list box, click the name of Mail campaign.

Related Topics:
Creating a new Mail
Save Mail campaign to send later
Insert "Personalized" field in a message
Insert items in a message
Formatting message text
Understand message format
Creating a Pre-formatted customized message
Change the priority of an outgoing mail message
Requesting read reciept for sent messages
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24.3 Inserting items in a message

24.3.1 Insert File Attachment

Insert file attachments

To insert a file in a message

1. On the Send Mail window, click Insert menu, then click File Attachment. Or directly click the
"Attach" button on the toolbar.

2. Find the file you want to be attached.

3. Select the file, and then click Open. The file is listed in the Attach box in the message header.

Note
You can also add a text (*.txt) file into the body of your mail message by clicking the Insert menu and
then clicking Text from File.

Related Topics
Insert a picture
Insert a hyperlink or HTML page
Insert a HTML code

24.3.2 Insert a Picture

Insert a picture in a message

1. In the Send Mail window, click where you would like the image to appear.

2. On the Insert menu, click Picture, and type the location of your image into the Picture Source box
(please note the location is HTML souce code, not the local folder).

3. Enter Layout and Spacing information for the image file as needed.

Notes

·   If you cannot select the Picture command, make sure HTML formatting is turned on by clicking the
Format menu in the message window and then clicking Rich Text (HTML). A black dot appears by the
command when it is selected.

·   The picture must be stored on your web server. You must use a FULL URL address for the Picture
Source box. For example, http://www.mailcommunicator.com/images/mailcomm.gif. You can NOT
make a local copy of this image with your message.

More Info: please visit
http://www.dynamicwebcenter.com/knowledgebase/screenshot/mailcomm/insert_html.html

Related Topics
Insert an attachment
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Insert a hyperlink or HTML page
Insert a HTML code

24.3.3 Insert a Hyperlink or HTML page

Insert a hyperlink or HTML page

1. In the Send Mail window, click where you want to add the hyperlink or Web page text.

2. To add a hyperlink, click the Insert menu, and then click Hyperlink. Select the file type, and then
type the location or address of the link.

3. To add an HTML page, click the Insert menu, and then click Text from File. Change the Files type
box to HTML Files, and then find the file you want to add.

Tips
·   If you cannot select the Hyperlink menu command, make sure that the HTML formatting is turned
on by    clicking the Format menu in the message window and then Selecting a Rich Text (HTML).
And then tick the mark that appears by the command when it is selected.

·   To create a hyperlink from message text, simply select the text before you create the hyperlink.

Related Topics
Insert an attachment
Insert a picture
Insert a HTML code

24.3.4 Insert HTML Code

Insert HTML Code

1. In the Send Mail window, click where you want to add the hyperlink or Web page text.

2. To add a hyperlink, click the Insert menu, and then click HTML Code. Select the file type, and then
type the location or address of the link.

3. Type the HTML code into the HTML code box, and click OK .

Tips
·   If you cannot select the Hyperlink menu command, make sure that HTML formatting is turned on by
clicking the Format  menu in the message window and then select Rich Text (HTML). A selection tick
mark appears, by the command when it is selected.

·   You can also add / edit HTML directly to the message by clicking the Source tab on the Message
box.

Related Topics
Insert an attachment
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Insert a picture
Insert a hyperlink or HTML page

25 Using HTML Formatting

Using HTML formatting

When you create messages using HTML formatting, only mail programs that support HTML can read
the formatting. If the recipient's mail program does not read HTML, the message is displayed as plain
text with an HTML file attached.

To use HTML formatting

In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML).

Notes
To edit the HTML source tags, click the Source tab and start editing.

Related Topics:
Formatting message text
Creating a Pre-formatted customized message

26 Report and Log file

26.1 View Mail Campaign Report

View Mail Campaign Report

It allows you to track your mail sending process to see whether it is successful or not. If there is any
error that has occured during the sent mail, the error will be logged in here.

1. In the Mail Communicator window, click the Reports menu from menu bar.
2. Then choose Mail Campaign Report.

Related Topics:
View Unsent Email Address Report
View Send mail Error Report
View Skipped Email Address Report

26.2 View Send mail Error Report

View Sent Mail Error Report

The Sent Mail Report will contain mail campaigns that has failed to be sent. The cause of a failed Mail
campaign sending is issues connecting to the SMTP mail server. The issues can vary from a wrong
user name and password to requiring Secure connection.
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To view the Sent Mail Error Report:

1, In the main window, click Report from menu bar.
2. Choose Sent Mail Error Report.

Related Topics:
View Unsent Email Address Report
View Mail Campaign Report 
View Skipped Email Address Report

26.3 View Unsent Email Address Report

View Unsent Email Address Report

The Unsent Email Address Report will contain mail campaigns that has unsent emails on them. This
will show the email addresses that was unsent and the reason..

To view the Unsent Email Address Report:

1, In the main window, click Report from menu bar.
2. Choose Unsent Email Address Report.

Related Topics:
View Send mail Error Report
View Mail Campaign Report 
View Skipped Email Address Report

26.4 View Skipped Email Address Report

View Skipped Email Address Report

The Skipped Email Address Report will contain mail campaigns that has skipped emails on them. This
will show the email addresses that was skipped and the reason..

To view the Unsent Email Address Report:

1, In the main window, click Report from menu bar.
2. Choose Unsent Skipped Email Address Report.

Related Topics:
View Send mail Error Report
View Unsent Email Address Report
View Mail Campaign Report 

27 Troubleshooting & FAQ

27.1 Can I send message in HTML format?

Can I send message in HTML format?

Yes, you can send message in HTML format with Mail Communicator.
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Mail Communicator has a built-in WYSIWYG HTML editor which allows you to create the HTML
message within the program.

To create HTML format message:
1. Open the Send Mail window by going to File menu, New and Message Template
2. In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML) menu
item. This option is selected by default.

Tips
1. To edit the HTML source tags, click the Source tab and start editing.
2. You can set the default format of the message to HTML format under the File/Configuration
window.
3. When you create messages using HTML formatting, only mail programs that support HTML can
read the formatting. If the recipient's mail program does not read HTML, the message is displayed as
plain text with an HTML file attached.

Related Topics:
Using HTML formatting
Troubleshooting and FAQ

27.2 Can I send attachment?

Can I send attachment?

Yes. You can insert attachments with Mail Communicator.

1. In the Send Mail window, click the Attach button from the toolbar, or click the Insert menu from the
menu bar and choose File Attachment.
2. Locate the file you want to insert and click OK.

Related Topics:
Insert file attachment
Troubleshooting and FAQ

27.3 Can I insert picture in message?

Can I insert picture in message?

Yes. You can insert picture (or image) in a HTML message with Mail Communicator.

To insert picture in message:
1. In the Send Mail window, change your message format to HTML by clicking the Format menu and
choosing Rich Text (HTML) .
2. Click the Insert menu and choose Picture .
3. Type the full URL address of the picture location on your web server and click OK.

Note :
You can only insert picture that is stored in a web site. You cannot insert a picture that is stored on your
local PC. If your picture is stored on your local PC, then you need to upload it to your website and use
the full URL address of the picture location.
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Tips :
You can only insert picture in HTML format message. The Insert/Picture menu will be disable if your
message is in Plain Text format.

Related Topics:
Insert a picture
Troubleshooting and FAQ

27.4 What format of mailing list file do Mail Communicator support?

What format of mailing list file does Mail Communicator support?

Mail Communicator uses the normal plain text format mailing list. The simplest format is just one email
address per line. There is no limit on how many email address can have in the mailing list.
Because Mail Communicator can accept multiple customized fields in the email message. So that you
can include additional information such as name, company, address, client ID etc in your mailing list,
and seperate each field by a comma.
For example a simple list might looked like this:
address1@domain1.com
address2@domain2.com
address3@domain3.com
......................
A more complex mailing list consist of extra fields can be like this:
address1@domain1.com,name1,company1
address2@domain2.com,name2,company2
address3@domain3.com,name3,company3
.....................

Related Topic:
Mailing List File format
Insert "Personalized" field in a message
Troubleshooting and FAQ

27.5 My send mail progress stop in the half way, how can I continue
from the place it stop?

My send mail process stops (or interrupts) half way through; how can I
continue from the place it stopped?

When you send a mail campaign, your mail message is stored in the Outbox folder. If a send mail
process stops (or interrupts) half way through the process, then the mail message will stay in the
Outbox. You can continue (or re-start) sending the message from the place where it stopped.

1. In the main window, click the Email Campaign Tab.
2. clik on the Outbox folder.
2. Double click the mail message you want to continue to send from the mail list to open the mail
message.
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3. Change the Send time to Now and click the Send button on the toolbar.
4. You can choose to continue or re-start from the beginning.

Tips
You can also set the program to automatically continue to send from the place it stopped. Simply check
the "Continue to send a mail campaign if it stops or interrupts in half way through" box under the
File/Configuration window.

Related Topic:
Creating a new mail
Troubleshooting and FAQ

27.6 What happen if I send in HTML but recipient's email program
does not support HTML?

What happen if I send message in HTML format, but my client's email program
does not support HTML?

Mail Communicator supports both HTML (Rich Text) and Plain Text file format.

When you send messages using HTML formatting, actually, the program will send TWO formats at the
same time. If your client's email program supports HTML format, HTML format message will be
displayed. If the recipient's mail program does not read HTML, the message is displayed as plain text
with an HTML file attached.

So that you can feel free that all the clients can read your HTML messages correct.

To use HTML formatting

In the Send Mail window, click the Format icon on the toolbar and click Rich Text (HTML).

Related Topics:
Using HTML formatting
Troubleshooting and FAQ

27.7 I send a test message to myself, but I did not receive it, what I am
doing wrong?

I send a test message to myself, but I did not receive my testing email, what am
I doing wrong?

There are many factors may cause your mail message to not be deliveried. Please check following:

1. Check your SMTP mail server and be sure you use the correct SMTP mail server provided by your
ISP or network administrator.
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Note : If you have multiple accounts from several different ISPs, some ISP may restrict you to use their
SMTP mail server only if you are connected to the internet through their dial up connection directly. For
example, if you are connected to the internet through ISP A, you can NOT use ISP B's SMTP mail
server to send mail.

2. Be sure your mailing list file format is correct. The mailing list file must be in plain text file format with
one email address per line. Please use the Import Mailing List  function to import your existing
mailing list to the correct format and try again.

3. Please check the Filter setting under the File/Configuration window, and be sure your email
address is not included in the Filter list.

If you have checked above and still cannot send mail, please forward the "error.log" file which can be
found in the same directory of Mail Communicator to support@apexpacific.com.

Related Topic:
Troubleshooting and FAQ

27.8 Can I retrieve addresses from Microsoft Outlook?

Can I retrieve addresses from Microsoft Outlook?

Yes, you can do that. If you wish to retrieve address from certain folder inside the Microsoft Outlook,
you can use the Retrieve function in List Tools to obtain the address from the mailbox file. You can
further specify which field you want to retrieve the email address from. For example, to obtain "from"
field or "to" field.
If you need to get the list of addresses from the address book, you can just simply use Microsoft
outlook to directly export the address book into a text file with comma delimited option and you are
ready to run with it from there.

Related Topic:
Retrieve email address from file or mail folder
Troubleshooting and FAQ

27.9 What happen if our mailing list is in Excel format, can we still use
Mail Communicator?

What happen if our mailing list is in excel format can we still use Mail
Communicator?

Yes you can definitly use the Mail Communicator when the mailing list is in Excel format.

Mail Communicator uses mailing lists in TXT format, an Excel mailing list can be converted into the
TXT format very easily. Use the save as function to save the list as CSV file and choose comma
delimited. This should save the list into a format which opt-in emailer can handle.

Tip: You can import your existing text based mailing list into the Excel for data manipulation purpose,
then re-save it as CSV format for use.

Related Topic:
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Mailing List File format
Retrive email address from file or mail folder
Troubleshooting and FAQ

27.10 The functions that included in MailComm that can help with your
email list management.

The functions of Mail Communicator that can help with your email list
management

There are a number of powerful email list management functions built into the Mail Communicator.

Functions like Sort and Deduplicate, Merge and Remove can simplify your job and make mailing
management a breeze.

Sort and deduplicate functions can sort a list and put it into alphabetical order and remove all the
identical duplicated entries. This is extremly useful for initial sorting and cleaning of the mail list.

Merge is also very useful, when wanting to combine mailing lists. It can combine one with another, or
combine multiple mailing lists together into a destination list.

Remove is another powerful function in the Mail Communicator, it enable users to remove one list
from another, or remove multiple lists from one list and stored the result. The speedy nature of the
above functions combined can make your mailing list management much simpler and easier.

Retrieve function allows you to retrieve email addresses from a file or mail forlder. For example, you
can retrieve email addresses from your Outlook Express mail folder.

Related Topic:
Mailing List Tools
Retrieve email address from file or mail folder
Troubleshooting and FAQ

27.11 I have a large mailing list, how do I set up MailComm for easy
sub/unsubscription ?

I have a large mailing list, how do I set up the Mail Communicator for easy
subscription and unsubscription management with the list?

To set up a subscribe mailing list in Mail Communicator is easy. Mail Communicator has provided you
a simple and easy way to manage your subscribe mailing list easily from your desktop.

There are two ways to subscribe and unsubscribe people from your mailing list.

1. Specify a subscribe mailing list with your mail account.

2. Use Message Rules to Subscribe or unsubscribe.

For more information, please click "Subscribe or unsubscribe to a mailing list".
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Related Topic:
Mailing List File format
Mailing List Tools
Troubleshooting and FAQ

27.12 How to filter unwanted email address from list when sending
email?

How to filter unwanted email address from list when sending email?

There are a number of powerful email list management functions built into the Mail Communicator.

Functions like sort and deduplicate, merge and remove can simplify your job and make mailing
management a breeze.

Sort and deduplicate functions can sort a list and put it into alphabetical order and remove all the
identical duplicated entries. This is extremly useful for initial sorting and cleaning of the mailing list.

Merge is also very useful, when wanting to combine mailing lists. It can combine one with another, or
combine multiple mailing lists together into a destination list.

Remove is another powerful function in the Mail Communicator, it enable users to remove one list
from another, or remove multiple lists from one list and store the results. The speedy nature of the
above functions combined can make your mailing list management much simpler and easier.

Tips:
You can check your email address  or mailing list from the Send Mail window directly by clicking the
Check Mailing List button on the toolbar. This will open the Mailing List Tool window automatically so
that you can perform the task you want.

Related Topics:
Mailing List Tools
Retrieve email address from file or mail folder
Troubleshooting and FAQ

27.13 How do I specify the number of emails I want to send from a
mailing list?

How do I specify the number of emails I want to send from a mailing list?

You can specify the number of addresses you want to send during each session. This number tells
Mail Communicator how many messages you wish to send regardless of how many are actually in the
list. If you have a mailing list containing 10,000 addresses, you can specify how many emails you want
to send in each session.
This field is located above the "From" field on the sending screen of the program.
For example, if you enter 5000 in this field, the program will stop sending at number 5000.
The following setting is also available:
5000: send first 5000 emails in your mailing list and stop.
5001-10000: skip first 5000 emails and send from 5001 to 10000 then stop
5001-: skip first 5000 emails and send from 5001 to the end.
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Related Topics:
Mailing List Tools
Mailing List File Format
Troubleshooting and FAQ

27.14 How can I retrieve un-deliverable(or returned) email addresses
automatically?

How can I retrieve un-deliverable(or returned) email addresses automatically?

When you send bulk email, you will experience that you always get many returned  (or undeliverable)
message bounce back as people change their email address from time to time.

To remove those undeliverable email addresses manually is very difficult and time concern.

Fortunately, Mail Communicator provides you a powerful function to allow you to retrieve the
undeliverable email addresses from returned emails automatically and add them to the master
Removed mailing list.

For more information please click retrieve undeliverable email address automatically.

Related Topic:
Get Returned(or un-deliverable) email address automatically
Mailing List Tools
Troubleshooting and FAQ

27.15 How to Send Personalized Messages?

Insert HTML Code

1. In the Send Mail window, click where you want to add the hyperlink or Web page text.

2. To add a hyperlink, click the Insert menu, and then click HTML Code. Select the file type, and then
type the location or address of the link.

3. Type the HTML code into the HTML code box, and click OK .

Tips
·   If you cannot select the Hyperlink menu command, make sure that HTML formatting is turned on by
clicking the Format  menu in the message window and then select Rich Text (HTML). A selection tick
mark appears, by the command when it is selected.

·   You can also add / edit HTML directly to the message by clicking the Source tab on the Message
box.

Related Topics
Insert an attachment
Insert a picture
Insert a hyperlink or HTML page
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27.16 How to Send Mail Campaign in Schedule Mode?

How to send mail campaign in schedule mode?

Save mail campaign to send it later
You can save a draft of your mail campaign to work on or send it later. To save a mail campaign, click
the File Menu and select Save to send later menu item. The mail will be saved in the Draft folder.
You can open the mail campaign later by double clicking on the Mail name.

Send mail at a specified time
You can specify the Date and Time you wish to send a mail message, and the mail will be sent at the
specific time. Simply click the Send ...message this session Now box and click At , then it will display
the Time box to allow you to specify the time you would like to delivery this message. When you click
the Send Button, the Mail campaign will also be saved in your Outbox. It will be sent automatically with
the time that the message has reached the time you specified.

Related Topics:
Save a Mail Campaign to Send Later
Creating a new Mail
Troubleshooting and FAQ

27.17 Can I send email to a database(MS Access or SQL) directly?

Can I send message to a database(MS Access and SQL) directly?

Yes, you can send message to a MS Access or SQL database directly. Please follow the steps below:

1. Open "Send Mail" window.
2. Click the "Browse" button on the "To:" box.
3. On the "Select Mailing List" window, click the "Open a mailing list from database" option, and then
click the "Build..." button.
4. Then follow the screen prompt on the "Select Database" window and create your database
connection string.

See Also:
Create and send a new Mail

27.18 Can I send auto follow up message automatically?

Can I send auto follow up with Mail Communicator?

Yes, you can send auto follow up with Mail Communicator. This is a powerful feature that allows you to
manage your follow up campaign automatically.

Please simply follow the steps below:

1. Create a "Send Rule".
Before you can send an auto follow up mesasge, you need to create a "Send Rule" by clicking the
"New / Send Rule" button from the toolbar. Under the "Send Rules" screen, there is only one condition,
which is to specify the days you want to send the follow up message and 3 actions:
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Condition:
After _____ days from [Date] field in mailing list. Please specify the days you want to send the
message compare with the [Date] in the mailing list.

Note: your mailing list must contain a date field as [Date]. For example:
[Email], [Name], [Date], [Company]
sales@apexpacific.com, Sales, 12/03/2002, Apex Pacific
......

Actions:
Send message
Remove email address from the mailing list - this action will be used if you don't want to send message
from this mailing list again.
Move email address to a <mailing list> - this action allows you to move the matched email address to
another mailing list.

2. Attach "send rules" to your email.
On the "Send Mail" window, click the "Send _____ message this session" drop down list and choose
"Send Rules" option, then select the "Send Rule" you want to attach with the mail.

Once you click the "Send" button, the email will STAY in the "Outbox" folder, and check the "Send
Rule" every day and send the message automatically if the condition is matched.

28 Technical

28.1 Technical Support

Technical Support Contact

Please check the "Troubleshooting & FAQ" section before contacting our support.

We continually provide free technical support for all registered clients. You can receive additional
information and technical support in the following ways:

WWW
Look for updated information and easy solutions to common problems on our WWW site, at
http://www.apexpacific.com/knowledgebase/mailcommunicator/index.asp 

Email
Send us an e-mail message with full details of your problem to: support@apexpacific.com

With this method, your problem can be better described and it also alleviates time zone problems.

Phone
Phone our support Helpline at (AU) +612 9662 3433. Fax: (AU)+612 9662 6372.

Phone our support Helpline at (US) +1 323 319 6318

Related Topics :
System configuration

http://www.apexpacific.com/knowledgebase/mailcommunicator/index.asp 
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Troubleshooting and FAQ

29 Registration and Ordering

29.1 Ordering Mail Communicator

Ordering Mail Communicator

Click on the "Help/Order" menu item from the menu bar and follow the instructions on the "Order "
window.

Please click on the "Help/Order" menu item from the menu bar of the program. You will be
automatically connected to our on-line order page by clicking on the 'Order Now' button from the
"Order Information" screen. Once your payment is approved, an Order Confirmation with your
registration code will be sent to you via email within 24 hours.

We accept all major credit cards such as Visa, Master Card and American Express. You can also
pay by International Money Order and Bank Cashier Check by printing out the order form and
sending your payment to the address listed at the bottom of the order form page.

Related Topics:
What is Registration?
Why should I register?
About Registration Code?

29.2 What is Registration ?

What is Registration?

This software has a trial version.  This means that we have made the software available to you for a
free for 30 days evaluation period. You are entitled to evaluate the software for up to 30 days without
obligation to pay. After 30 days, if you decide to keep the software, you must register your copy with us
or one of our authorized resellers.

The trial version has some limitations:

  1. You can only send 500 emails at a time.
  2. Nag-screen.
  3. You can't use the software after trial period.

To unlock the limitation of the trial version, you need to purchase a registration code.

Related Topics:
Ordering Mail Communicator
Why should I register?
About Registration Code?
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29.3 Why should I register ?

Why should I register?

The trial version has limited functionality. To unlock the full feature set of this product,  it must be
registered to remove these limitations. For many people, the most pressing reason to register is to get
rid of the annoying nag box which pops up at the most inconvenient times.

But besides this, Registration entitles you free technical support and minor upgrades to the software.
Registration may also entitle you to discounts on other software releases from our company. We will
also send you information bulletins by email to let you know about what's happening with our products.

Furthermore, by registering the software, you provide us with the resources and incentive to support
the software with updates and to develop additional quality products in the future.

Related Topics:
Ordering Mail Communicator
What is Registration?
About Registration Code?

29.4 About Registration Key

About Registration Code?

Entering your Registration Key
After purchasing a key, you will be sent an email containing your key and detailed instructions on how
to enter it into Mail Communicator.

Simply click the "Help" menu item from the menu bar and choose "Register",enter your registration
details, and then click the "Register" button. You will be connected to our online authentication
database to verify your registration code.

Invalid Registration Key
If you receive a message informing you that your key is invalid,  please take the following steps before
contacting Technical Support:

1. Check your Register Name carefully and make sure you have enter the correct Register Name
exactly as we provide in the "Order Confirmation" email.

2. Check and make sure your registration code is entered correctly. The key is case specific and
contains no spaces. Please use "Copy" and "Paste" function to enter your registration key.

Your registration code has been cancelled
If you are receiving an error message stating that "Your registration code has been cancelled", please
understand that this is because we are using an online authentication system to track each registration
code when you use your software each time. Although our server is active over 99% of the time,
occasionally it does go down. If you receive a message informing you that your registration code has
been cancelled, please follow the instruction below to re-activate your registration code:

1. Connect to the Internet and open the "Register" window.
2. If you are connected to the internet through a "Proxy Server", please make sure to enter your
correct "Proxy Server " address in the "Configuration " setup window.
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3. Check your "Register Name" carefully and make sure it is entered correctly as we provided.
4. Click on the "Active" button and follow the instruction on the screen.
5. Close the program and re-start.

If this does not work, please contact Apex Pacific or authorized dealer with your Client ID# for help.

Related Topics:
Ordering Mail Communicator
What is Registration?
Why should I register?

30 About Apex Pacific

30.1 About Apex Pacific

About Apex Pacific

Apex Pacific Pty Ltd is a leading Internet Marketing software company that specializes in developing
advanced Internet Web Promotion application solutions. Our company conducts intensive and
extensive research and development in the fields of Web promotion mechanisms and advanced
intuitive user interfaces for implementation on the Internet.

Our Software contains all of the most powerful #1 "ALL-IN-ONE " internet marketing and web
promotional tools that you need to explode your business on the internet. We are widely recognized as
a world leader from our Apex Pacific's groundbreaking Search Engine Optimization and Pay Per Click
software. Our multi-award winning SEO software is a professional web promotional tool that
automatically submits your website to 1000+ major search engines with just a few clicks of a button
and provides you the tools to get your website to be listed at the TOP position of all major search
engines.

We at Apex Pacific are especially dedicated to providing smart solutions and applications for the
internet marketer. We have extensive experience in building high quality and professional internet
marketing tools and applications and provide SEO and PPC Training as well as services. With Apex
Pacific's guidance, your company will achieve the ultimate Internet marketing approach, and gain the
specific Internet solutions to suit its unique corporate needs.  

Related Topics:
Other web promotion products from Apex Pacific
Contacting Apex Pacific

30.2 Other web promotion products from Apex Pacific

Complete Web Solution Products from Apex Pacific.

Apex Pacific has the most advanced Internet Marketing Software for your business. Our software has
been created and mastered by our software developers to bring your business success! We have a
complete "ALL-IN-ONE" Internet Marketing and Web Promotional tools that you need to send your
business booming on the Internet. We are widely recognized as the world leader in quality Internet
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Marketing and Web Promotion software.

SEO Suite - The #1 combined web promotion and search engine submission tool that drives traffic to
your website for FREE. The SEO Suite contains 25 SEO tools to boost your website to the top 10. A
few tools included are, Web Site Optimizer, Search Engine Submitter, Link Building Tools, Web
Ranking and Reporting Tools.

PPC BidMax - The ultimate and most powerful Pay-Per-Click bid management tool that manages your
keywords and bids for all the major search engines such as, Google Adwords, Yahoo! Search
Marketing, MSN AdCenter etc. Our advanced bidding algorithm will help to save you money and allow
you to generate comprehensive reports that clearly indicate your ROI so you can monitor the success
of your campaign.

Mail Communicator - The automated email marketing solution to make your email marketing campaign
easier. You can create, manage and track results of your permission based bulk email campaigns and
newsletter distributions. A fantastic and easy to use software!

Internet Marketing Suite – The "ALL IN ONE" Internet Marketing Package. This is the complete internet
marketing solution for all your web promotion needs. The Internet Marketing Suite provides you a total
solution to manage your Search Engine Optimization, Per Per Click Bid Management and Email
Marketing.

Related Topics:
About Apex Pacific
Contacting Apex Pacific

30.3 Contacting Apex Pacific

Contacting Apex Pacific

Apex Pacific Pty Ltd
Suite 2, Level 1,
6 - 8 Crewe Place,
Rosebery NSW 2018
Australia
Phone : +61 2 9662 3433
Fax : +61 2 9662 3422
Email :
Sales/Products Enquiry: sales@apexpacific.com
Support/Customer Service: support@apexpacific.com
Web :
http://www.apexpacific.com

Related Topics:
About Apex Pacific
Other web promotion products from Apex Pacific
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